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Legacy 4.0 
Presentation Guide
The following steps are a suggested guideline when demonstrating Legacy 4.0 to a group.  This presentation is designed around a situation where all the members of the group can see either the actual computer screen or a projected display onto a large surface.  Depending on the details explained, this demonstration can last from 45 minutes to an hour or more. 

This presentation uses several sample family files in DEMO directory on this CD.  These files have been carefully prepared to show the many features of Legacy.  They contain many pictures, sounds and videos as well as source documentation, notes, duplicate records and other situations that are used during the demonstration.  The DEMO directory is designed to be placed as a subfolder of C:\LEGACY\DATA.  Please us Windows Explorer to drag the DEMO folder from the CD and drop it on the C:\LEGACY\DATA folder. Next make a copy of the Refresh.bat file on your Desktop and run the it.  This will copy all the demonstration files down into the correct folders for use while demonstrating.  The original files are therefore not touched and are available for refreshing at any time.

Bullet points set off each piece of information to explain.  Actions that you are to perform are italicized and placed in parentheses.  Addition information can also be found within parentheses that are not italicized.  This information may or may not be pointed out, depending on the time allowed and the questions that may arise.

Starting the Program

[image: image10.png]Edit (John Fitzgerald).

Edit Marage.

Add »
View »
Notes.

Pictures

Tag

Delete.
Uniink. »




From the Start Menu

· When Legacy is installed on your computer, an entry is made in the Program menu of the Start menu.  

· To start Legacy, press the Start button, move up to the Program menu and then move to the Legacy line then over and click the Legacy icon line.  Legacy is then loaded and displayed on your screen.

The Family View

· The normal opening screen is the Family View.

· The shows a Husband, Wife, Husband’s Parents, Wife’s Parents and their children.  

(Point the mouse to each box as you say them.) 
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The Pedigree View

· You can also work from the Pedigree View. 

(Click on the Pedigree tab)

· The Pedigree View shows four generations.  This can easily be changed to five generations.  

(This is done by right clicking on the background and then selecting Toggle Display of 4/5 Generations.)

· The two grids show the surrounding relatives for the currently highlighted person.  If you click on a different person, the information in the grids changes to the relatives of that person.

Navigating

· Navigation is done using the buttons on the left and right edges of the window.  

· If a button is colored blue, you can click it to move one generation in that direction.  

· The button at the left edge of the screen moves to a younger generation.  
(Click the blue button to the left of the main person in the first generation.  This will bring up Caroline Kennedy.  Now, click the button a second time.  This will bring up Rose Schlossberg.  

· The Preferred child is displayed when moving to younger generations.)  

· The blue buttons along the right edge of the screen move the display to an older generation.  

(Click the button to the right of Joseph Patrick Kennedy and then again to the right of Patrick Joseph Kennedy, his father.)  

· You can work from either the Family View or the Pedigree View.  

· Anything you can do in one view can also be done from the other view.  This includes adding people, edit, linking, etc.  It just depends on which view you are most comfortable working from.

Right-Click Menus
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If you ever wonder what you can do at any certain place, right-click the mouse at that location.  
(Right-click the mouse on John Fitzgerald Kennedy to display a popup menu.)

· From here you can edit John or his marriage,  …

(Move the cursor down from the first line to the second line of the popup menu.)  

· add surrounding relatives,  …
(Move the cursor over the Add line so that the sub-popup menu appears.)  

· view various lists,  …
(Move the cursor over the View line so that the sub-popup menu appears.)  

· add notes, pictures, tags (which will be described later) and delete and unlink people.

· Notice that if you try to delete a person or unlink a person, …

(click on the Delete option) 

· a list pops up first, showing you all the surrounding relatives that will be affected by that action.  

(After a few seconds, press the Cancel button on the Delete window to close it without going through with the deletion.)

(Now, right-click on Jacqueline Bovier at the top of the Spouse/Children window.  After a few seconds, right-click on Caroline Bovier Kennedy right below Jacqueline.)

(Now, right-click on Joseph Patrick Kennedy Jr. at the top of the Siblings window in the lower grid.)

(Finally, right-click on the background.)  

· From here you can change from four to five generations.  
(Do this.  Then right-click again on the background and change it back to four generations.)

· Let’s go back to the Family View.  

(Click on the Family tab.)
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Back to the Family View

Navigating

· Navigating on the Family View is also easy.  

· To move up a generation, just click in one of the Parent’s boxes.  
(Click on JFK’s parents, Joseph and Rose.)  

· The parents move down to become the husband and wife.

· We can just keep clicking on the parents to continue to move into the past.  

(Click three more times on the same parent’s box until Patrick Kennedy and Mary Johanna are displayed as Husb and Wife.)

· Notice that Legacy always shows you the relationship of the current individuals to the starting person, which is normally you.  

(Point to “2nd Great Grand Father” above Patrick Kennedy.)  

· In this file it is how everyone is related to John F. Kennedy.  This starting person can be changed at any time.  

(This is done by highlighting the person you want to start with and then selecting Relationships… from the Tools menu.)

· To move back down to the descendants, simple click on a child’s name.  This will bring that child and their default spouse up to the Husb and Wife positions.  
(Click on Patrick Kennedy’s name in the child list.)

(Now, click three more times on the children with the asterisks in front of their names.  While doing so say…)  

· You may notice that I am clicking on the children with the asterisk at the beginning of their names.  I am doing this because these children have been set as the direct line back down to JFK.  

· (This feature can be set by selecting a starting person and then choosing Set Direct Line as Preferred from the Tools menu.)
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The Back Button

· How many of you have ever gotten lost in your family file?  
(Hold up your hand.  Usually many people in the group will also hold up their hands and agree.)  

· You go back a few generations and then switch over to some cousins and then you’re lost.  You can’t find your way back…

· Well, Legacy has a solution for that.  It’s the Back button.  By pressing this button up here in the left corner, you can go backwards to the last 160 places you have been, in order.  
(Press the Back button eight times to retrace your steps.  This will leave you back at JFK.)  

· If you go too far, press the Forward button.  

(Press the Forward button once.)

· You can also bring up a list of all the place you have been,  
(Press the little down arrow between the Back and Frwd buttons.) 

· and jump back to anyone you want.  
(Double-click on John Fitzgerald Kennedy’s name.)

[image: image15.png]urces for: Jacqueline Bou

Events Name of Source Detail =
Unspecifed —
Name
y
Chistened
Death Jossph P Kennedy, A Lie and Times, by David [[pg 132
Zoom
Bural
Notes Help
Research
Medical Cite a Master
Death Cause —]| | Source
Relgion
LoSE
LOSP BowierlLes Showal
Vi Avstols Omassis I Eente-

= Summary | Publ. Facts | Text | Comments | = Detail | = Output | Repository | Pictures |

Location
= Select,
=] Add.. |@
Phone
URL

E-Mail




Editing a Person

· You can edit either of the two main individuals on the Family View by just clicking anywhere on their information.  

(Click somewhere on the info below JFK’s name.)

· This brings up the Information screen.  Here you can enter or edit the person’s vital information, such as their name, title, birth, christening, death or burial.  

(Run the mouse pointer down these fields.)

· There is also a field for a User ID Number and an Ancestral File Number.  
(Point to these two fields with the mouse.)

· Each person has an Alternate Name List.  
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(Click on the AKA icon to bring up the Alternate name list.)

· Here you can record any name spelling variations as well as nicknames. 
(After a couple seconds, press the Close button.)
· You can even add letters and special symbols from other languages.

(Point to the special characters ribbon with the pointer.)
· This is the Event window.  

(Point to the Event window with the pointer.)

· Here you can record any other events that you know about for this person.  This might include Military Service, Graduation, or, if you find conflicting information, you can record alternate birth and death information here. 

(This point will be used later in the Merge demo when combining two individual’s information.)

· To add a new event, press the Add button.  

(Press the Add button to bring up the Event window.)
· Let’s enter a Graduation.  
(Type G.  The rest of the word will fill in automatically.)  

Tab to the Date field.)

(Type in a date such as 6 Jun 1944.)  

(Tab to the Location field.)

(Type in Stanford, tab to the Comments field and type Graduated with honors.)
(Press the Save button.  The new event will be added to the Event window.)

· You save any changes by pressing the Save button.  

(Press the Save button.)
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Editing a Marriage

· This button is the Marriage Information bar.  
(Move the mouse pointer back and forth on top of the Marriage bar.)

· Pressing it brings up the Marriage screen.  

(Press the Marriage bar.)

· Here you can add the marriage date and place as well as any ending status and data.
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If you know that a couple had no children, you can specify this by checking the This Couple Had No Children box.  This will then show in the Child List.  Since this couple already has children listed, the option is disabled.  

· If there are special circumstances, for instance the couple was not married, you can change their Family View labels and edit report wording to correctly reflect the nature of the relationship.
(Point to the Wording Options area at the bottom of the Marriage Information screen.)
(Now, press the Cancel button.)
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Colored Icons

· I will now explain the other icons on the screen.  

(Slowly move the mouse cursor over the large and small icons at the bottom of both the Husb and Wife boxes.  Popup descriptions appear as the cursor moves over them.)

· Color is used on these icons to indicate that they contain information. 

· If an icon is gray, like these,  …

(click on the parent’s box above Jacqueline to bring her parents down and then show that the Siblings, Notes and Pictures icons are gray) [image: image20.png]i Merge Options
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· it means that there are no siblings, notes or pictures entered yet.

(Click the Back button.)

· But if the icons are colored, like these …

(run the mouse over the colored icons), 

· it means they have information to show you.

· The icons can also be changed to show your preferences.

(Right click anywhere on the icon line up to display the Customize Toolbar screen)
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Spouses

(Move the cursor over the Wife icon below JFK.)  
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This is the Spouse icon.  I can tell that John was married only once because there is only one person on the button and the number 1. 
(Move the cursor over the Husb icon below Jacqueline.)  

· I can tell that Jackie was married twice than once because there are two people on the Spouse icon and the number 2.

· Clicking on the button brings up the list of spouses.  

(Click on the Husb icon below Jacqueline.)

· If I want to display a different spouse, just double-click on the name.  
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(Double-click on Aristotle ONASSIS to display him as the husband.)

· Now, I could pop the list back up to change back to John F. Kennedy or I could just press the Back button.  

(Press the Back button in the upper left corner to go back to JFK.)
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Siblings

· The [image: image67.png]


 button is the Siblings icon.  This will show a list of the brothers and sisters of the person.  

(Press John’s Sibling icon.  After a couple seconds, press Close.)

Notes
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 icon is for Notes.  

(Press the Notes icon.) 

· You can enter three different kinds of notes for an individual… General Notes, Research Notes and Medical Notes.  

(Click each tab as you say the words.)

(Click back to the General tab.)

· Each note field can hold hundreds typewritten pages of notes so there is a lot of room for person stories and other information.

(Press the Save button to close the window.)
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Pictures, Sounds and Video

· The [image: image3.png]


 icon is the Pictures icon.  

(Press the Pictures icon.)

· You can scan or add an unlimited number of pictures, sounds and video clips for each individual.  When you add a picture to an individual, Legacy just links to the existing graphic file.  It does not load the picture into the family file like other programs do.  This results in a much smaller family file and gives the capability of using the same picture for several individuals.  For example, if you have a picture from a family reunion that has twenty people in it, you can link all twenty people to the same picture.  You don’t have to duplicate the picture twenty times!

(Double-click on the first picture.  This will zoom it into a separate window.  After a couple seconds, press the Close button.)

· Pictures can have sound attached to them.  

(If you have sound capability on your computer, click on the caption of the third picture and then press the Play button.)

· You can also have stand-alone sounds.

(Click on the second boxes caption and press the Play button if you have sound.)

· Video clips can also be added.  
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 (Click on the caption of the fourth box and press Play.)  

· Adding a picture is simple.  Just press the Picture or the Scan a Picture buttons.  

· Then tell Legacy where your pictures are (or place a photo on the scanner).  

(Go to the KndyPics folder.)

· You can preview each picture before selecting it by just clicking on the picture name.  

(Click on a few of the names to show the picture to the right.)

· To select a picture, highlight it and then press OK.  
(Highlight a Kennedy picture and press OK.)

· You can then add a caption, date and description to the picture.  The description can be up to 65,000 characters.

· If a picture has been scanned upside down, you can turn if back over.  

(Press the Flop button.) 

· You can also rotate it 90 degrees at a time.  

(Press the Rotate 90 deg. Button four times)

· Color pictures can be converted to black and white if desired.

· Legacy supports 34 different graphic file formats.  This includes all the normal formats plus many that most of us have never heard of.  

· You can load in a picture in one format and save it to any of the others.

· Pictures can also have their sharpness, contrast and brightness adjusted and then resaved. 
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You can add sound to a picture by pressing the Sound button.  
(Click the Sound button.)

· Most computers with sound cards have a jack where you can plug in a microphone.  To narrate a picture, just press the Record button and talk into the mic.  

(Click the Cancel button to close the Sound window.)

(Click the Close button on the Display Picture window to close it.)

· Pictures can be rearranged by simple dragging them to a new location.  
(Drag a picture from one box to another.)

(Press Close to close the Picture Gallery and go back to the Family View.)

· These other icons can also show you more information.  

(Run the mouse over the other icons under John and Jacqueline.)
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 stands for Events. 

(Move the cursor over the Events icon.)

· If you have entered additional events for a person, the Events icon will be colored.  Pressing it brings up the Information window where you can view the events.  
(Press the Events icon and then move the mouse cursor around the event box.  After a few seconds, press the Cancel button in the upper right corner of the Information screen.)
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 icon stands for Sources.  If you have entered any source documentation for this person, the icon will be in color.  

(Press the Source icon.)

· Pressing the icon brings up the Assigned Sources window showing what sources have been cited for each event in this person’s life.

· We will get into source documentation a little later in the demonstration.

(Press the Close button.)

· The [image: image6.png]Bh



 button is for Alternate Names (or Also Known As).  It will be blue if there are different name spellings for this person.  

(Move the cursor over the Alternate Names icon…but you don’t have to press it.)

· The [image: image7.png]


 button stands for Multiple Parents.  

(Move the cursor over the Multiple Parents icon.)  

· You can attach more than one set of parents to an individual if you need to.  This might be done, for example, to trace an adoptive line and a bloodline.
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 icon is for the Address List.
(Move the cursor over the Address List icon.)
· You can add addresses for printing mailing labels and nametags.

· You can also add two phone numbers, and Internet-enabled e-mail and Web page addresses.

· The [image: image9.png]


 icon is for the To Do List.
(Move the cursor over the To Do List icon.)
· You can make lists of research tasks, correspondence and other things you need to accomplish.

· The To Do List can be printed out to take on research outings.
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(Put the mouse over the Temple icon.) 

· This is the LDS icon.  

(Press the Temple icon.) 

· It displays the LDS screen for entering ordinance dates and temples if you are recording these.  If you don’t want to see these fields, you can turn them off in the program from the Customize window.

(Press the Cancel icon.)
· You can tag records to create groups of related or unrelated people.  For example, you might want to print a Family Group Sheet for all the tagged people…or export all the tagged people.  Legacy has some powerful options to make tagging very useful.  For example, you can select an individual and quickly tag that person and all their ancestors…or all their descendants.  You could then export only the tagged people to give your cousin just a certain line out of your file.  I will be explaining more about tagging as we go along.
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These indented boxes are Tags.  Clicking on a tag turns it on.

(Click in one of the tag boxes.)  

· Clicking again turns it off.  

(Click again in the box.)
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Name List

· This is the Name List.  

(Click the Name List button.)  

· Also known as the Index.

· It shows all the names in the entire family file.

· There are several ways in which you can find a specific name in the list.

· First, you can type the name in the Name box.  

(Start typing SCHW.)  

· As you type each letter, Legacy jumps to the nearest matching name.

· You can also jump to the names beginning with a certain letter by clicking on the Alphabet row.  

(Click on a few letters, like A C K.)

· Or, you can use the scroll bar and arrows to manual look through the list.  

(Drag the scroll bar up and down and use the up and down arrows to move around a little.)

· Notice that as you click on specific names, their detail information is shown on the right.  

(Make sure the Detail tab is selected and then click on a few different names.)
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The detail information shown on the right can be changed if you like.  For example, if we wanted to change the Burial information to something else, we just click on the Bury label.  

(Click on the Bury label.)

· Customize Display screen opens and we can select anything from the list.

(Click on Select button to the left of Burial to display the list of options.)  

· Lets choose the Relationship field.

· Now, when we click on anyone, it shows how he or she is related to John Kennedy.

(Click on a few different people.)
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This list can also be printed.  Just press the Print button.  

(Click on the Print button.)

· This brings up the List Report Options window.  Let’s customize it a little.  

(Uncheck the RIN and the Sex fields and then check the Born and the Relationship fields.)

· Now we will look at the report.  

(Click the Preview button.)

· All reports in Legacy can be previewed on the screen before committing them to paper.

· Here is a list report showing how everyone in the file is related to JFK.  

(When the report is displayed, click on it two times to zoom in.)

(After a few seconds, press Close on the preview screen and then press Close on the List Report Options screen.)

· The three columns at the right of the list right here 

(point to columns 1, 2 and 3) 

· are the tag columns.  Remember, I told you that you could tag records for certain purposes.  Well, you can actually put up to three tags on any record.  This lets you create three different tag groups.  Using Tag 1 you might mark a husband and all his ancestors.  And then using Tag 2 you might mark the wife and all her ancestors.  You could then export all Tag 1 records to a new file and all the Tag 2 records to another file.  In this way you can easily split a file into two smaller pieces…or give just a branch of your family file to your cousin.

· Let me show you how easy it is to tag lines.

· First, let’s clear all the tags on all the records.

· Click on the Options button and then choose Advanced Tagging…
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(Click the Options button and then choose Advanced Tagging) 

· The Advanced Tagging window appears:
· Now let’s click on the Clear All Tags, All Levels, For Everyone button 
(click on the button)  

· We could have also just cleared the tags on a specific level if we wanted to.  

· Now we want to tag John F Kennedy and all his ancestors.

· We will bring up the Advanced Tagging window again.

(click on the Options button and then choose Advanced Tagging) 

· on Level 1 …

(point to the 1) 

· John Fitzgerald Kennedy …

(locate JFK in the list and click on him) 

· and all his ancestors.  

(Click on the Ancestors button.)

· On the Ancestor Options window we can choose to either tag just JFK and his direct line ancestors…his parent, grandparents, great-grandparents…

(click on the Ancestors option) 

· or the entire ancestor line…including all the aunts, uncles and cousins.  

(click on the Entire Ancestor Line option button.)

· This time we will just do the direct line ancestors.  

(click back on the Ancestors option and press OK.)

· As you can see, JFK and all his direct line ancestors are now tagged.  

(move the cursor up and down along the Tag 1 column to point out the X’s there.)

· We could now export just the Tag 1 people, or print a Family Group Sheet for the Tag 1 people.

· While we are here, let me point out that each window with a grid on it has a Zoom button.  If the text in the list is too small, you can make it larger.  

(Click on the Zoom button and then double-click the 14 point option.  The text will get bigger.)

· If you set the size to Automatic, … 
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(click Zoom again and double-click on Automatic) 

· the text will automatically resize proportionally to the size of the window. 

· You can stretch most windows to be larger or smaller.  

(Grab the bottom right corner and shrink the Name List window to be about half the size.)

· As you can see, the text changes size.

(Drag the bottom right corner to make the window larger.)

· Legacy remembers the size and location of each window you resize or move.

(Now, click on the Close button.)

Source Documentation

(Make sure that you are back to JFK and Jacqueline.  Press the bookmark button if necessary.)
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We all know of the importance of documenting the information we collect.  Legacy has a lot of features that make source citation very easy.  Sources are kept in a Master Source List.  Each main source is kept only once in the master list but can be cited by each piece of information that was found in it.  Each citation can include extra detail information such as the page number or microfilm roll number where the information was found within the master source.  

· Let me show you an example.  Let’s open Jackie’s Information window.

(Click on Jackie’s birth date to open the Info window.)

· I can tell by looking at her information that the birth and death fields have source citations tied to them because their labels are colored.

(Point to the Born and Died labels.)

· If I press the Sources button…

(Press the Sources button.)

· to show the assigned sources, I can see that there is one source citation for the birth and the death fields.
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Notice that the name of the source is the same in both cases.  These citations point to the same master source.  

(Point to the two “Joseph P. Kennedy, A Life and Times”)

· As you can see, the detail is different.

(Point to the Page 133 and Page 134.)

· The specific information was found in two different places in the book.

· Let’s add another source citation to the Death information.

· First, we click on the Death line.

(Click the mouse cursor on the Death line.)

· The source we want to cite is already in the Master Source List so we will click this button…

(Click the Add a Source from Master List… button.)

· which brings up the list.  Here is a list of all the master sources we have entered so far.

(Move the mouse pointer up and down the list.)
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We found some more information on the death date on page 206 in The Fitzgerald’s and the Kennedy’s book.  We highlight the source name…

(Click once on the The Fitzgeralds and the Kennedys line.)

· and press Select.

(Click on Select.)

· The Detail window then pops up where we can indicate that we found this information on page 206.

(Type Pg 206 on the detail line and press Tab.)

· You can also enter an excerpt from the source in this area.

(Point to the text box Enter the Actual Source Text (optional) label.)

· You can also indicate a Surety level, showing how confident you are of the information found in this source. 

(Point to the Surety level numbers.)
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If you have an original Death certificate, that would be a level 4.  If you find a piece of paper in a bottle on the beach saying “The president is dead,” you would probably give it a lower number.

(Click on the 0 level.)

· Now we will save the citation.

(Click the Save button.)

· As you can see, a new source citation has been added to the Death field. 

· Now let’s add a new source to the Buried information.  We click on the Buried line and press the Add a New Source button.

 (Press the Add a New Source button.)

· This is where we enter a new master source.  We start with the Source Name.  This is the name we want to remember the source by.  It is usually part of the source title or an abbreviation of it.  Let’s call this The Big Kennedy Book.

(Type The Big Kennedy Book in the Source Name field and then press Tab.)

· We now indicate the source Type.

· This is a book.

(Type BO to fill in the Book type.  The rest of the name will fill in automatically.)

· If we press the down arrow…

(Press the down arrow at the right end of the Type field to display the Type List.)

· we can see all the default source types.  You can use anything on the list or add new types.

(Press Close and then tab to the Author field.)

· The author of this book is Fred Williams.

(Type Fred Williams into the author field and then tab to the Title field.)

· This is where you enter the complete title of the source.

(Type The Complete Kennedy Book from 1800 to 1980 and tab to the next field.)

· In the Publication Facts field you enter when and where the source was created.  You can get some help on filling in this field if you like.  Depending on the type of source…

(Point to Book in the Type field.)

· you can press the Assistant button…

(Press the Assistant button.)

· and Legacy will give you the fields commonly associated with this type of source.

(Type something like:  New York, New York in the Publication Place field, Doubleday Press in the Publisher field and June 3, 1985 in the Publication Date field.  Now press the Create button.)

· You can also enter the actual text of the source if you like.

(Press the Text of Source tab.)

· And any comments you have about the source.

(Press the Comments tab.)

· When the source has been entered, press the Save button.

(Press the Save button.)

· The source is added to the Master Source List and we are then prompted for any detail information concerning this citation.  Let’s say the Death date was found on page 234.

(Type 234 in the detail field and then press the Save button.)

· The Death information now cites the new master source we just entered.

· Let’s add the same source to the name.

(Click on the Name field, press the Add a Source from Master List…, double-click The Big Kennedy Book, type Pg 234 in the detail field and press Save.)

· We have now cited the same source for the Name.

(Press the Close button.)

· OK, that’s one way to enter sources.  It’s not too bad, but there’s a lot of clicking involved --- even if the source is already in the master list.  Pretty soon, it going to seem tedious.  And if it’s tedious, you will be tempted not to do it.  You may hold out for a while but sooner or later you will want to skip it.  There has to be an easier way.  There is.  Legacy has a Source Clipboard that lets you memorize source citations and assign them with a click of a button.

· Let’s start by entering a new person.

(Click the Save button in the upper right corner of the Information window.)

· Let’s add another son down here.

(Click on the empty child box just below Patrick Bovier Kennedy and then choose the Add New Son option.)
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Many times, you will have a book where you find several individuals.  Each person you enter will have the same source citations for each piece of information.  This is a job for the Source Clipboard.  The Source Clipboard is accessed by these four buttons on the left.

(Point to the four buttons.)

· The top button displays the clipboard.

(Press the top, triangle button then press the Clear All button.)

· Here we can select a master source.

(Press the Set button.)

· Let’s use The Big Kennedy Book.

(Double-click on The Big Kennedy Book.)
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And let’s say were are working on page 200.

 (Click in the detail field and type Pg 200.)

· This citation is now on the Source Clipboard.

(Press the OK button.)

· I’m now ready to enter people I found in the book.

· First, we found Bill Kennedy.

(Type Bill in the Given Names field and then tab four time to the Birth field.)

· He was born on Jan 1, 1965…

(Type Jan 1 1965 in the date field and press Tab.)

· in Boston.

(Type BO in the place field. Boston, Suffolk Co, MA will fill in.)

· He was christened three day later in the same place.

(Type 4 1 1965 in the Chr field and BO in the place field.)

· He took a long trip and died 6 days later.

(Type 10 jan 1965 in the Died field and B in the place field.  Belgium will fill in.)

· Now I want to cite the sources.  Remember they’re on the Source Clipboard. 

· To cite the source for the Name field, I can click in the field…

(Click in the Given Names field.)

· and if I press the single bar button, it will cite the source on the clipboard for the name.  See, the name label turns blue. 

(Point to the Name field labels that are blue.)

· If I press the Sources button, I will see that the source citation has been entered for the Name.

(Press the Sources button and point to the citation on the Name line.)

(Press Close to close the source window.)

· Now, I could click in the Birth field and press the single bar and then the Christen field and press it again…or I could press the triple bar button…

(Press the triple bar button.)

· and cite the source for every field that I have filled in.  All these labels turn blue.

(Point to the blue labels.)

· If I press the Sources button…

(Press the Sources button.)

· you can see that they all have that source citation.

(Press the Close button after a few seconds.)

· So, all you have to do now is enter a person, click the triple bar button, save them, enter the next person, click the button and so on.  Enter your sources is now very easy.

· Now, you may have noticed that the Source Clipboard…

(Press the top triangle button to pop up the Source Clipboard.)
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has room for more than one source.

(Point out the five tabs along the top.)
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There are times when you may want to cite more than one source at a time.  For example, you may have a Family Group Sheet that lists a submitter’s name and address.  On the sheet, the submitter has listed two or three other sources that they used to fill in the information.  You may want to cite all these sources.  You can load one on each tab.

(Click the Source 2 tab and then press Set and double-click The Kennedy’s.)

(Click the Source 3 tab and then press Set and double-click Who was JFK?)

(Click the OK button to close the clipboard window.)

· Now I three sources on the clipboard.  If I press the triple bar button, all three sources are cited for each piece of information.

(Press the triple bar.)

· If I press the Sources button…

(Press the Sources button.)
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I have all three sources for each one.

(Point to the groups of three citations for each field.)

· That is how you cite sources.  

· The source citations will print on reports and in the books.  You can also print a Source Citation report that  lists each master source along with all the individuals and marriages that cite them.

Searching

· Legacy has a lot of powerful search features.  To search for individuals or marriages, press the Search button.
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(Click the Search picture button.)

· There are several ways in which you can search.  The first is Query By Example.  

(Click the Query By Example tab if it is not already selected.)

· This is just a fill-in-the-blanks type of search.  Let’s look for everyone born in Boston. 

(Click in the location field to the right of the Birth date field.  Type boston.  Then click on the Either option in the Gender box and the Anywhere in Field option in the How to Find box.)

· Now, let’s create a list of the results.

(Click the Create List button.)

· Here is a list of the 19…

(point to the number 19 in the title bar.)

· people born in Boston.  Notice that wherever I click, Boston is found in the birth location.

(Click on several different people in the list to show that Boston is in the birth location for each one.)

· This is now an active search list.

(Move the mouse cursor up and down in the list of names.)

· If we close this window, we can move from one name to the next by pressing the F3 function key.
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(Start pressing F3 several times.)

· Shift-F3 moves backwards through the list. 

(Press Shift-F3 a couple times.)

· If I were to quit Legacy and start back up again, the search list would still be active, and the F3 key would take me to the next person from where I left off.

· I can always pop up the last search list by pressing the Results button.

(Press the Results button.)

· Now, lets go back to the Search screen.

(Click on the Search button at the bottom of the window.)

· Now, let’s search for all the people who died in Boston.

(Double-click on boston and press Ctrl-X to cut it and then click in the Died location field and press Ctrl-V to past boston there.)

· But instead of creating a new list of these people, I want to add them to the list of people born in Boston.  When I create a search list, I have three options.  The first is to “Clear Search List Before This Search”.  The second is to “Add Results to Existing Search List”.

(Click on this option.)

· The third option is to just search the existing search list for matches.

(Click on this option.)

· I want to add to the existing list so I will select the second option.

(Click back on the second option and then press the Create List button.)

· Notice that the number of people in the list has increased from 19 to 24, meaning that we have added file new people.
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(Point to the 24 in the title bar.)

· Let’s go back to the search window.

(Press the Search button again.)

· Another type of search is a Detailed search.

(Click the Detailed Search tab.)

· Here you can be very specific about what you search for.  And you can combine criteria using AND’s and OR’s.

· Let’s look for some records that have a Religion event.

· Let’s look for women…

(Click the down arrow on the Look For Whom box and select female.)

· with an event…

(Click the down arrow on the Where to Look box and move the scrollbar down until Event Name appears and then click on it to select it.)

· equal to…

(Just point to the words Equal To that are already in the How to Look field.)

· Religion.

(Click in the What to Look For field and type Religion.)

· We want to create a new list so we will use the Clear Search List option.

(Click on the Clear Search List before this search option and then press Create List.)

· All seven of these women have a Religion event in their records.

· There are also some other Miscellaneous Searches available in Legacy.

(Click the Miscellaneous Searches tab.)

· Often, when someone sends me a genealogy file, I want to know how far back the oldest generation goes.  It can be quite a puzzle trying to find the longest line back if you do it manually.  You have to keep retracing and trying other lines.  Legacy has a built-in search that will quickly produce a list of the people in the oldest generations.

(Click on this option.)

· You can also find the youngest generations.

(Click on this option.)

· Or the ends of lines.  People with no parents or no children.

(Click on these options.)

· You can search for loners.  People who are in the family file but not linked to anyone yet.

(Click this option.)
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You can even find records with bad dates.  Maybe someone sent you a file where they were not careful about the dates and maybe entered the 30th of February.

(Click the Cancel button.) 

· You can also globally search and replace on over 100 different fields, which can be a real time saver when a large number of the same kind of changes need to be done in a large family file…

(On the menu bar click on Search and choose Search and Replace from the Search menu.)
· [image: image51.png]


There are a variety of options to help you make the right kind of searches and replacements…

(Change the Find Where field to Notes-General, Find What to MA, Replacement Text to Massachusetts, check Match Case, and select Anywhere in field and Replace only Found Text with Replacement Text.)
· With or choices carefully selected we are ready to start…

(Click the Start button. Next click the Replace button two times, pausing briefly between each replacement, then click Replace All button.)
· See how easy it can be?

(Click the OK button.)
Multiple Views

· It is often nice to be able to see two different places in one family file at the same time.  You can do this by selecting View and choosing Split Screen from the menu.

(Click on View and select Split Screen.)

· Here, we have two views into the Kennedy file.  We can go to the view on the right and switch it to the Pedigree view.
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(Click on the Pedigree tab on the right view.)

· In the left view we can navigate around to a different part of the family file.

(Click the parent’s box above the Husband four time.)

· Being able to see and compare two different locations in a family file can be very useful.  But what is often more useful is to be able to compare two different family files side-by-side.

· Let’s change the left view to a different file.

(The left window should be the current window and its title bar should be colored.  If not, click on the title bar of the left window to highlight it.)
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We can choose File, Open and then choose a different file to view.

(Click on the File pull-down menu, move down to Open Family File… and click.)

· Let’s open the Bovier file.

(Click on Bovier and press OK.)

· Now we have two different family files open at the same time.  Let’s change this one to show the Pedigree view.

(Click the Pedigree button on the left window.)

· OK, lets say the file on the left is my file.

(Move the mouse around the Pedigree view in the left window.)

· And the file on the right is a file my cousin sent me.  She sent me a GEDCOM file and I imported it into its own family file.

(Move the mouse around the right Pedigree view.)

· Now, in my file I have been trying to do research on this Joe Patrick Kennedy for years and have hit a brick wall.

(Point to Joe Patrick Kennedy in the left window.)

· But now I see that in this file there is a Joseph Patrick Kennedy that seems to be the same person as my Joe Patrick Kennedy.  

(Point to the Joseph Patrick Kennedy on the right and then to the Joe on the left.)

· But in this there are lots of ancestors!

(Move the mouse around all the ancestors to the right of Joseph Patrick Kennedy.)

· I want these people in my file!  But I only want these ancestors, not all the other people in the file.  There must be an easy way to copy just Joseph Patrick Kennedy and his ancestors from my cousin’s file to mine.

· Well, in Legacy there is an easy way.  Just drag this Joseph Patrick Kennedy from this file over to mine and drop him on Joe.

(Slowly drag Joseph Patrick Kennedy from the right file over to the left and drop him on top of Joe Patrick Kennedy.)
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When I do this, Legacy asks me who I really want to copy.  A window appears with some choices.  Do I want to copy just Joseph?

(Point to the Just the Individual Above button.)

· Joseph and his immediate family?

(Point to the Family button.)

· Everyone in the file?  His ancestors?  His descendants?

(Point to each of these buttons as you mention them.)

· Well, I want all of these ancestors.

(Move the mouse around the ancestors in the right window.)

· So I will press the Ancestors button.

(Press the Ancestors button.)

· From the Ancestors Options window I can choose to copy just the direct line ancestors…
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(Click on the top Ancestors option.)

· This would be Joseph, his parents, grandparents, great grandparents, and so forth ...  or the entire ancestor line…

(Click on the Entire Ancestor Line button.)

· which includes all the cousins and aunts and uncles.  This is the one I want, so I’ll press OK.

(Press the OK button.)

· Now, I’ll start the copy process.

(Press the Start Copy button.)

· Now, I’m given a chance to attach a source to each record copied in case I want to remember later where these records came from.  For the demo, I’ll skip this step.
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(Press the Don’t Assign a Source button.)

· Legacy now copies Joseph and his ancestors from my cousin’s file on the right to my file on the left.  All the information, notes, pictures, sources and links are included.

(Wait for the message box to appear that indicated the import is complete.)

· Now, at this point I have a Joe Patrick Kennedy and a Joseph Patrick Kennedy in my file, right?  They are really the same person.  Legacy knows this so it now takes me to the Merge screen…

(Press the OK button on the message box.)

· with Joe and Joseph displayed side-by-side.  Since I will be showing you how the merge process works in a minute, I will just quickly merge these two Joe’s…

(Click on the Joseph name in the differences box and then press the Merge Right Individual into Left Individual button and then the Close button.)

· to show you that I now have all these ancestors linked into my file.

(Move the mouse around all the new ancestors in the left window.)

· Legacy makes it really easy to copy from one file to another without bringing in all kinds of other unwanted information that would have to be manually cleaned out later.

(Close both windows by clicking on the X in the upper right corner of each.)

(Open the Merge file by clicking on the File pull-down menu, choosing Open Family File… and then double-clicking on the Merge file.)

Merging

· I would now like to show you the powerful merge feature in Legacy.  How many of you have ever merged records before?  

(Raise your hand and look at the group.  Several usually raise their hands.)

· How many of you have enjoyed the experience?

(Raise your hand.  Usually there are a few moans and no one raises their hand.)

· Legacy has the absolute best match merge feature of all the genealogy programs.  

· Here is a quote from Dave Berdan, the president and one of the developers of Legacy:

“Over the past ten years or so, I have used just about every genealogy program on the market for tracking my own family research.  Each time I would try to do a match-merge, I would get this terrible feeling and was scared to death to press the Merge button.  This was because I just didn’t know what was going to happen.  First of all I couldn’t see enough information to be certain that the two people I was combining were actually the same person.  And then, after merging, I always ended up with multiple parents, or duplicate children.  I usually created more of a mess than I had to begin with.  So, when developing Legacy, we spent months designing a process that would let the user see all the surrounding information concerning the people to be merged.  We don’t make you look down a narrow tube…we give you a magnifying glass!”

· There are generally two situations where you need to merge duplicate individuals in your family file.  

· First, over time, you inadvertently enter a person twice into your file.  As the size of your file grows, this can happen more frequently.  It’s a good idea to periodically check your file for dups.

· Second, and probably the most common, is that someone sends you a file with some common relatives and you import it into your file.
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In Legacy there are two common ways to merge individuals.

(Click on the Merge picture button to display the popup menu.)

· The first is the Manual Merge.

(Move the mouse over the Manual Merge option.)

· This is where you choose two people that you think might be the same person.  Maybe you saw the name appear twice in the Name List.  You choose these two people and merge them together.

· The second is where you let Legacy run through your family file and search for possible duplicates.

(Move the mouse over the Find Duplicates option.)
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I’ll show you this option now.

 (Click on the Find Duplicates option.)

· The process starts at the Merge Options screen.  This is where you can tell Legacy how you want to look for duplicates.  

· You can match the exact spelling of the surnames, or use the Soundex codes.

· You can match a certain number of letters of the given name.

· You can specify that the birth dates be within a certain range.

· There are quite a few options you can change to make the matching as tight or loose as you want.  For this demo we will just use the default settings and continue on.

(Press the Continue button.)

· Legacy now runs through the entire family file and looks for duplicates.  It then displays the first pair in the Merge window side-by-side.

(Move the mouse back and forth between the first two individuals.)

· Notice down here in the bottom left corner that this is the first pair of 12 that Legacy found.  We are going to look at 12 pairs of possible duplicates.

(Point to the 1 of 12 in the lower left corner.)

· [image: image59.png]*General | *Family | *Events || *Pictures | *Notes | Research | *Medical | Addr | LDS |

Rose Fitzgerald-2]

Rose Fitzgeralc-[30]

Caption Caption
Date Date
Desc. Desc.
Sound Sound

Edit Left Delete Left_| Delete All Left << Copy. << Copy All Edit Right

EditLeft ‘ ‘Swap Left/ Right Edit Right
Merge Right Individual nto LeftIndividual Skip to Next
20f5 Print Close Help ¥ AutoMerge




These two Leelands are the first pair.

(Point to the two Leelands.)

· So, Legacy shows you the two individuals side-by-side.  It also show you a little of their personal information, their spouse and their parents.

(Point to each of these pieces of information as you mention them.)

· In this box below, you are shown only the information that is different between the two people.

(Move the cursor around the Fields that are different box.)

· In this case, the only difference is the given name and the birth date.

(Point to the two Leeland(e)s and the two birth dates in the differences box.)

· The first thing we need to do is decide whether or not these two Leelands are the same person.  We can see some of their information, but this may not be enough.  Often, you need to see a lot more in order to determine if they are duplicates.

· So, Legacy gives you all these tabs across the top to let you see all the surrounding information for the two individuals.

(Move the cursor over all the tabs along the top.)
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This is the Family tab…

(Click on the Family tab.) 

· where you can see the Parents, Spouses, Brothers and Sisters, and Children of both individuals.  Here you can see who they are linked to.  Do they come from the same family situation?

· If they have any Events, Pictures, Notes, Research Notes, Medical Notes, Addresses, or LDS information, you can see all of these.

(Click each successive tab as you mention them.)

· Now, looking at all this information I have decided that these two Leelands are the same person.

(Click back on the General tab.)

· So now we need to take care of the different information between the two.

· Let’s do the birth dates first.

· If I knew for a fact that he was born on the 29th of May, 1917, I would just leave this date selected and let the other go away.

(Point to the 29th and then the 30th.)

· But if I didn’t know which date was correct, which one would I want to keep?

(Pause and wait for an answer.  Someone will usually say, “Both of them.”  If no one answers within a few seconds, answer for them…”I would want to keep both of them.”)

· If I don’t know which is correct, I want to keep them both.  I don’t want to throw any information away.

· And so, this little black button over here lets you do something with the other piece of information.

(Click on the black button to the left of the Birth Date label.)

· I can either copy the other date to the Notes or, what we usually do with a date like this is to create an Alternate Birth Event.

(Click on the Copy Right Birth Information to Events options.)

· Now you can see, on the Events tab, that there is an alternate birth event for this information.

(Click on the Events tab.  Stretch the date column a little wider to show the entire date.)

· We don’t lose the information.

· Now let’s take care of the given names.

(Click back on the General tab.)

· The two given names are spelled a little differently.  Since every individual has an Alternate Names list, we will copy the other name there.
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(Click on the black button to the left of the Given Name label and choose the Copy Right Name to Alternate Names option.)

· We have now taken care of all the conflicting data without throwing anything away…so let’s merge them together.

(Press the Merge Right Individual into Left Individual button.)

· The two people are merged together and the next pair is displayed.

(Point to both Roses that are now displayed.)

· Now, remember, we were just on 1 of 12, right?  Now we are on 2 of 14!  What happened?  Somehow two more pairs got added to our list.

· This is what happened.  Whenever Legacy merges two individuals together, it takes another look at all the surrounding relatives of each person to see if it can find more duplicates.  For example one may have had a father named Bob and the other a father named Robert.  Or mothers named Pegi and Margaret.  Since the names didn’t match, they weren’t found in the first pass.  But Legacy takes a closer look at these situations and decides that they are probably duplicates and adds them to the end of the list.  This way Legacy is very thorough in finding duplicates. 

· So, this second number will tend to grow a little as we go through the merge process.
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(Point to the 14 in the lower left corner.) 

· Here are two Roses.  We can look at their Families, Events, Pictures…

(Click on the Family tab, then the Events tab, then the Pictures tab.  The two pictures for the Roses are the same.)

· The pictures are probably a dead giveaway.

· Notes, Medical Notes.

(Click on the Notes tab then skip down to the Medical tab.)

· Notice that some of the tabs have an asterisk in front of their label.  This indicates that there is information on these tabs.  

(Point to a few of the tabs with an asterisk.)

· The others are blank.  This saves you time when looking around.

(Click back on the General tab.)

· So, these two are obviously the same person so lets see about the differences.  The only things that are different are the Notes, so let’s look at the Notes tab.

(Click on the Notes tab.)

· I can see that the information on each side is different.  I could mark a block and do a copy and paste…

(Mark the second paragraph by dragging the cursor over it.)

· but since I want the entire note I can just press the Append button and copy it all over.

(Press the Append button under the right notes.)

· I have now kept all the information.

(Click on the General tab.)

· So let’s merge the two Roses together.

(Press the Merge button and wait while three pairs flash by on the screen.)

· You might have noticed that three pairs of people just flashed by on the screen before stopping on this pair.  Those three pairs were AutoMerged.  If you have the AutoMerge option checked…

(Point to the AutoMerge checkbox in the lower right corner.)

· Then, if both individuals have exactly the same information, AND then have the same parents, spouses, siblings and children, AND if they have enough personal information for Legacy to almost absolutely determine that they are the same people, they can be AutoMerged.  If you don’t want to use this feature, just uncheck the option and each pair will stop on the screen for you to look at.

(Point to AutoMerge when mentioning it can be turned off.  Leave it checked.)

· You would now continue on through the remaining pairs, making sure they were duplicates, handling the conflicting data and merging them together.

· If you find two people who are not duplicated, you can skip them by pressing the Skip to Next button.

(Press the Skip to Next button.)

· Or, you can go back to a previously skipped pair.

(Press the Back to Prev button.)

· If you ever make any changes to a pair…

(Click the black button next to the Given Name label and choose Copy Right Name to Alternate Names.) 

(Click the black button next to the Death Loc label and choose Copy Right Death Information to Events.)

· and then decide that you made a mistake, you can retract the changes you just made to this pair by pressing the Undo button.

(Press the Undo button and then press Yes on the confirmation message.)

· If you have been working on a merge for hours and your spouse starts telling you that you had better turn that computer off and go to bed, you can press the Close button and Legacy will offer to save your place.

(Press the Close button and then press Yes on the Save Position window.)

· You can then quit Legacy, turn off the computer and then, when you allowed to use it again, restart the merge…

(Click the Merge picture button and choose the Find Duplicates option.)

· and Legacy will recognize that it has not finished the previous merge and offer to let you continue…

(Press the Continue Existing… button.)

· and then take you right back where you left off.  You can then continue until all duplicates have been taken care of.

· If you finish the merge process…

(Press the Close button and then press No on the Save Position message window.)

· and then start thinking that you made some mistakes, you can click on Edit…

(Click the Edit pull-down menu.)

· and then Undo the entire merge.  Legacy will put everything back the way it was before you started.

(Move the cursor over the Undo Merge option at the top of the menu.)

(Now reload the Kennedy file by clicking the File pull-down menu and selecting the Kennedy file which is at the bottom of the menu in the Recently Used files section.)

Reports

(Make sure John F. Kennedy is in the Husb position.  Click on his bookmark if need be.)

· Legacy prints all the standard genealogy reports you would expect.  To reach the report menu, press the Reports picture button.

(Press the Reports picture button.)

· Let’s start with Family Group Sheets.

(Click on the Family tab.)

· As you can see, there are lots of options that can be set for this report.  This goes for every report Legacy prints.  You can choose to customize the reports by including or excluding information.  You can include pictures…

(Click the Picture for Husband and Wife option.)

· You can choose to print Private Notes, if you have any.  

(Click the Print [[Private]] Notes option.)

· In every note and comment field in Legacy you can mark part or all of the text as private by putting two square brackets at the beginning and two at the end of the private section.  Private notes, by default, do not print on reports, are not exported to GEDCOM files and are not included on Web pages.  If you want to include the Private Notes, you have to check the box.

(Uncheck the Print [[Private]] Notes option.)

· You can include extra blank children at the end of a Family Group sheet if you like.

(Point to the Extra Blank Children setting.)

· You can include source citations at the end of the report.

(Click the Print Source Citations box.)

· Some of the reports have some extra option that open up here on the bottom.

(Move the mouse around the options at the bottom of the screen.)

· These let you print a whole batch of reports at once.

· By pressing the Preview button…

(Press the Preview button.)

· you can see any report on the screen before committing it to paper.

· On the Preview screen, you can zoom in and out.

(Click the left mouse button two times to zoom into the maximum size.)

(Click the right mouse button three times to zoom out.)

(Press the Close button.)

Descendancy Chart

· You can print descendancy charts…

(Click on the Descendant tab.)

· These can include boxes and shadows, pictures, vital information printed on one line or multiple lines for each individual.

(Point to these options as you mention them.)

Pedigree Charts

(Click on the Pedigree tab.)

· Pedigree charts can be printed with 4, 5 or 6 generations per page.  Pictures can be included.  Boxes can be printed around each person.  Cascading charts can be printed with continuation numbers.

Individual Reports

(Click on the Individual tab.)

· You can print Individual Reports.  These are similar to Family Group Sheets but focus on a particular person.  Again, there are many options.

Timelines

(Click on the Timeline tab.)

· Timelines can be printed for a person and their ancestors or descendants.  You can choose how many generations, how many years to spread across the page and a few other options.

Ancestor Charts

(Click on the Ancestor tab.)

· Ancestor Charts are similar to descendant charts in layout and options.

Lineage Charts

(Click on the Lineage tab.)

· Lineage Charts can be printed that show a person and their paternal ancestor line.  Each generation also shows the siblings, in order.

Other Reports

(Click on the Books / Other tab.)

· There are several other types of reports that can be produced by Legacy.  You can print an ancestor, descendant, or descendant narrative book report.

Ancestor Book

(Click the Ahnentafel (Ancestor) Book button.) 
· Here is the Ancestor Book window.  There are three tabs of options you can set before generating your book.

(Click on the Options tab.)

· On the Options tab you can choose how many generations you want to print.  Whether or not you want a Table of Contents or Index generated…and what style.
(Click on  the Page Layout tab.)

· The Page Layout tab lets you specify page breaks and indents.
(Click on the Heading Layout tab.)
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And, the Heading Layout tab lets you specify some more page layout options like page numbers, headings, subheadings and generation labels.
(Click on the Options tab again, then click the Report Options button, then on following tabs as you read them off.)

·  There are eight additional tabs of options here: Include, Format, Pictures, Sources, Page Setup, Header, Footers, and Fonts.

(Click on the Include tab.)

Again, you can include or exclude lots of different types of information.  How names and places are handled…

(Click on the Format tab.)

· You can include pictures…
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(Click on the Picture tab.)

· Source citations…

(Click on to the Sources tab.)

· Lots of things…

(Click on each tab as you mention them.)

· Page Setup…

· Header…
· Footers, and
· Fonts.

· You can Preview the book by pressing the Preview button.

(Point to the Preview button.)

· Or, you can send the output to a Rich Text File that can be loaded into WordPerfect or Word or any other word processor for further tweaking.  The RTF file contains all the codes necessary for your word processor to generate the Table of Contents and the Index.

(Press the Close button.)

(Click the Reports pull-down menu.  Pull the mouse down to each menu option as you mention it.)

· You can also print a Calendar Report that shows birthdays and anniversaries.

· A Surname a Summary report that tells how many times each surname is used and what year range it covers.

· A Source Citations report that lists each master source followed by a list of the individuals and marriage that cite it.

· A Relationships report that show how everyone in the family file is related to a particular person.

· A Potential Problems Report.

(Click on this option to bring up the Problems Report window.)

· This report tells about abnormalities in your family file.   Like people who were buried before they died, or born when their parents were 5 years old.  If a reported situation is verified, you can mark the record not to be included in future reports.

(Press the Close button.)

(Click the Reports pull-down menu and resume highlighting at the LDS Ordinances report line.)

· LDS Ordinance reports can be generated if you are tracking this information.

· Legacy also prints a lot of blank forms you can use.

(Highlight Blank Forms and then Census Forms.)

· You can print a specific form for each U.S. and Canada Federal census year.

· You can print a customizable Questionnaire to send to your relative to try and get information out of them.

· You can print a Relationship Diagram showing how the “Cousin Thing” works…who a 2nd Cousin, twice removed is.

· And, you can print a Research Log for tracking your efforts.

(Close the menu by moving the mouse over the background between the parent’s boxes and clicking.)

Calendar

· Legacy also includes a  handy calendar.

(Press the Calendar picture button.)

· There is a Month and Year calendar…

(Click the Month Calendar tab and then the Year Calendar tab.)
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These are useful if you know that someone was born on the 2nd Tuesday in May of a certain year and you want to know what date it was.

· There is also a Date Calculator that lets you reverse-engineer a date. 

(Click on the Date Calculator tab.)

· If you know that your great grandfather died on a certain date and you know how old he was when he died, you can easily figure when he was born.  This is common information on some headstones.

(Press the Close button.)

· You can pop up a quick Ages Report by choosing View, Ages.

(Click the View pull-down menu and then choose Ages…)

· This shows a couple and how old they were at major events in their lives.  You can print this report if you want to.

(Wait several seconds for the group to look at the window…then press the Close button.)

Other Nice Little Features

(If you have additional time, here are some more nice features in Legacy that are of interest to most people.)

Importing

Exporting

Web Page Creation

Backup and Restore

File Maintenance

Deleting a Family File

Copying a Family File

Rearranging Child and Spouse Order

Adding a New, Unlinked Individual

Master Lists

Address Labels

Name Tags
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